
As expected Neil Stahfest gave an excellent presentation 

on Windows 7.  He demonstrated how to load Windows 

7 upgrade Operating System into a computer that has 

either Windows XP or Vista O/S installed.  The second 

part of his presentation was how to transfer data from an 

older computer that uses Windows XP or Vista O/S to a 

newer computer using Windows 7, 64 bit O/S.  Many 

will benefit from the effort that Neil has put in, to 

research this information. 

 

TAPCUG has a second image projector that was being 

used by the Linux SIG at a more remote location.  The 

bulb has burned out which may cost several hundred 

dollars to replace.  Since we have purchased a newer 

projector that gives a brighter image the Board has 

decided to donate the  older projector to the Clover Park 

School District who would replace the bulb which would 

allow it to be used at the Lakes School Computer Club 

for students and the Linux SIG located in the Lakewood 

Presbyterian Church off 104th St.  A win, win for us all.  

In addition the Board is considering which Windows 7 

version we should purchase to upgrade our clubs 

computer. 

 

I am in the process of reviewing the Constitution and By 

Laws.  Not to stir things up, but rather to give the 

appearance of sounding knowledgeable instead of dumb 

when asked a question pertaining to the club.  Club 

traditions have served us well in the past and we shall 

continue those traditions unless it becomes necessary to 

make changes which would be done by consensus and 

Board approval. 

 

I have misplaced my copy of the Constitution and By 

Laws, or loaned it out to someone.  In any case Maggie 

has come to my rescue.  She emailed me a complete 

updated copy.   A big thank you goes out to Maggie. 
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GENERAL MEETING  

Saturday - February 13th - 9:30 AM 

Lakewood Community Center (see map on page 14) 
 

H o w t o  M a k e  M u s i c  
and Record w/Your Computer 

 
Presented by John Wickliffe 

 

Refreshments by:  

Alice Grenier 

 

Open Labs are every Friday, 10 AM ïNoon at the Lakewood Community Center  

Curtis J. Por®e Jr. 
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Discovering Windows 
7 ð Part  2  
by Neil Stahfest  

Tacoma Area PC User Group 

 
Last month we looked at some of the 

new Taskbar and Start Menu features.   

Weôve only scratched the surface.  This 

month weôll look at some more really 

useful features. 

 

Say you have a program on your Start 

menu that you use a lot. Open your Start 

Menu, point at it and right-click.  If you 

click on the little triangle on the right 

side of the program label youôll see a list 

of the last files you open using this 

program.  Now all you need to do is 

click on the one you want to access it.  

But wait!  Instead of clicking on the 

triangle, place your mouse pointer to the 

left of the triangle area and right-click.   

In the menu that opens you have a 

choice to pin the program to the Start 

Menu (which means that it will always 

be near the top for you) or pinning it to 

the Task Bar.  I suggest pinning it to the 

task bar.  Now to run the program 

instead of clicking on the Start Menu 

button and then double-clicking on the 

program name, all you have to do is 

point at the program on the Taskbar and 

click once to run it.  This ñtrickò also 

works with programs on the Start Menu 

that are listed under ñall Programsò.   

 

Letôs take this a step further.  Suppose 

the program you just pinned to the 

taskbar is a program like Microsoft 

Word or Excel.  Left-clicking on the 

program icon starts the program.  If you 

right-click on the icon youôll see a list of 

the ten most recent files that were 

opened with it.  Youôll also notice, that 

if you point at one of these files, you can 

pin it to the top of this ñrecentò list.  

You can also drag the names of files up 

and down on the list to change their 

relative position.  Finally, the name of 

the program (i.e. Excel) can be found at 

the bottom of the list so you have yet 

another way to click and run the 

program.  Donôt feel the need for this 

program to be pinned to your taskbar or 

Start Menu?  Just ñunpinò it.  This 

doesnôt remove the program from your 

computer, it just removes the link. 

 

Suppose you have one folder where you 

keep a lot of your work files, for a 

project.  I have a folder for my 

Windows 7 articles.  I could access this 

folder by going to the Start menu, 

clicking on Computer, then my hard 

drive, locating the folder and then 

clicking on it.  Windows 7 gives you an 

easier way.  To set it up; click on the 

Start Menu, Computer, the hard drive, 

locate the folder and left click on it and 

drag it to the Task Bar.  When it reaches 

(Continued on page 6) 
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February  Disk of  the Month  

F e b r u a r y  2 0 1 0  

South Sound Adobe 
User Group  
http://www.ssaug.org/ 
 

Meeting will be at Cascade Print, 

3321 S. Lawrence St, Tacoma, 

98409. Be sure to grab a ñbrown 

bagò. We are back to bringing in 

whatever we want to eaté. 5:30 for 

dinner and networking. 6:30 Meeting 

- 9:00 Dismissal 

 

We wanted to announce that the 

Adobe Photoshop Marketplace is 

live.   

 

Adobe Photoshop Marketplace is a 

place where anyone can publish 

information about their Photoshop-

related tools, solutions, or events, 

including details about user groups, 

hardware, software, training (e.g. 

books, DVDôs), events, etc. 

 

Hereôs the official link: http://

photoshopmarketplace.adobe.com 

Advanced SystemCare Free (formerly Advanced Win-

dowsCare Personal) has a one-click approach to help 

protect, repair, clean, and optimize your PC. With over 

20  MILLION downloads  since  2006,  this  fantastic, 

award-winning, free PC repair software is a "must-have" 

tool for your computer. 100% safe with no adware, spy-

ware, or viruses; a PC maintenance program thatôs in-

credibly easy to use.  Why waste money on expensive 

"registry cleaners" to fix your PC when Advanced Sys-

temCare Free will repair, tune, and maintain it for you 

for free!  

 

What's new in v3.4.0:  

+ Improved "System Optimization" for Win 7 and Vista  

+ Improved "Registry Fix" section  

+ Improved "Utilities" section  

* Fixed bugs in update function  

* Fixed general bugs 

 

Partition Wizard's  interface is simple and easy to use. 

All basic functions are displayed at the top of the win-

dow as large icons as well as on the menus, and more 

advanced functions like "wipe disk" are only found on 

the menu where you're not likely to choose them acci-

dentally. Like most programs of its ilk, you choose a se-

ries of actions, e.g., delete, resize, move and they're 

queued until you hit the apply button.  In tests, the pro-

gram just created, deleted, moved, resized, and copied 

partitions with no fuss or bother--or error messages. It 

also recreated a master boot record, wiped a disk, and 

even searched for, found, and recovered a deleted parti-

tion with nary a failure.  

Operating Systems: Windows XP, Windows 2000, Win-

dows Vista, Windows 7  

Requirements: 32- or 64-bit OS 

 

Sumatra PDF - . Do you really need a 218 MB PDF file 

reader?  Sumatra is a slim, free, open-source PDF viewer 

for Windows. It has a minimalistic design. Simplicity has 

a higher priority than a lot of features.  By comparison 

Sumatra is tiny at 1.2 MB yet it has all the ba-

sic features that a PDF reader should have and 

starts up very fast. It's designed for portable use: 

it's just one file with no external dependencies so you 

can easily run it from external USB drive. 

 

Unstoppable Copier - This program is great for recover-

ing files from scratched CD's or defective floppy/hard 

disks. Normally when your computer is unable to copy a 

file from a damaged disk it will abort and delete the por-

tion of the file it has copied. This program however will 

continue to copy the file right to the end. Any data that is 

not  recoverable  after  many retries  is  replaced  with 

blanks. This will allow you to truly recover every byte of 

information that is available for recovery. The program 

allows you to specify a single file, a group using wild-

cards (* and ?) or if you wish, select a starting folder and 

the program will copy all data from it and any sub fold-

ers it may contain. This program doesnôt just need to be 

used for copying files form defective disks, it can be 

used to transfer any files. 

 

 
$ 5.00  
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Check our web site, http://www.tapcug.org, for any 

changes that may have occurred after the Data Line 

was sent to our web site. 

 

Flight Simulator SIG:  Curtis Poree, e-mail: 

dustoff_2@msn.com / Neil Stahfest, e-mail: 

ncstahfest@msn.com.  

 

The next meeting of the Flight Simulator S.I.G. will 

be on the Tuesday, February 28th, at 7:00 PM at the 

Pierce County Lakewood Branch Library.   

 

Bring a flash drive or a blank CD to make copies of 

the files I will demonstrate. 

 

If you're having a problem with Flight Simulator or 

want to know how to get started, bring questions.  

We welcome people new to flight simulation and 

visitors at our meetings.  Although most of our 

discussions have been about Microsoftôs flight 

simulators, weôre always interested in hearing about 

other flight simulator programs.  If you have friends 

who might be interested in flight simulation, invite 

them to join us. 

 

Graphics/Scanner SIG: Barbara Grant, SIG Leader,  

Email: DL604@comcast.net 

Cancelled for lack of interest.  

 

 

Linux SIG: Joel Carlson, 253-549-2692; e-mail: 

Fox7777@CarlsonCo.net,  

 

The Linux SIG meeting is on the 3rd Tuesday of the. 

 

Doors open by 6:30 PM for setup. Super fast T-1 

internet connections available. 

 

Due to schedule conflict we are back at  the fire 

station, by water tower, training room #2. http://

Linux-Now.us Thanks, Joel 

 

We will look at the new released Linux distributions 

including Mepis Linux 7.00 (which runs on Debian 

& Kubuntu and adds improvements), PCLinuxOS 

2007 (which is well suited to new users), OpenSUSE 

11.0 with One Click Software Install, Puppy Linux 

4.0 for old/low capacity computers, flash drives, etc, 

Kubuntu 8.04 & Fedora 9. We will explore Virtual 

Private Networks (VPN), such as OpenVPN, virtual 

online meetings using Gizmo or Skype and Speech 

Recognition, such as XVoice. 

 

Linux is the revolution that is becoming the 

computer operating system of the future! Say good 

bye to expensive proprietary operating systems, 

viruses, worms, crashes, forced upgrades, infuriating 

popups & get a better, complete Linux operating 

system with all the applications you need for a very 

affordable price. 

 

Now is the time to make the move to Linux. We 

welcome you to join us. See http://www.Linux-

Now.us 

 

 

WIN XP/New Users: Paul Duhay, SIG Leader, 584-

6358, email: pduhay@sbcglobal.net 

 

Meets on the second Monday of the month, 5:30 - 

7:30 pm at the Lakewood Community Center 

Computer Lab. The next meeting will be February 

8th. 

 

The WIN XP/New Users SIG meetings will cover 

the basics of computer operation, including file 

management, Internet concepts, and application 

software (word processing, etc.). This SIG is open to 

any new or intermediate user who wants to begin to 

unravel the mysteries of their own computer. 
 

 

Special Interest Groups (SIG)  

O c t o b e r  F e b r u a r y  2 0 1 0  

http://Linux-Now.us
http://Linux-Now.us
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The Help Line  

 The following TAPCUG members have generously 

offered to serve as resources for other members in need of 

assistance with the programs listed. This service is free, 

but please respect their time, and use your manuals or the 

software vendor information line when recommended 

Call or E-mail your questions: 
 

A=Anytime D=Daytime E=Evening W=Weekend 

 

Where no time has been indicated, it is suggested you not 

call before 10 am or after 9 pm. 

 

 

 Word Processing(most): Maggie Smith        537-5494 

 E-mail: maggiebs@harbornet.com   A 

 

 

 Linux support: Joel Carlson 

 E-mail fox7777@CarlsonCo.net 

 

 John Wickliffe 

 E-mail: johnwickl@comcast.net  

 

 

 MS Word:  Maggie Smith          537-5494 

  E-mail: maggiebs@harbornet.com   A 

  

 

 

To make changes or add your name to this list,  

e-mail Maggie at maggiebs@harbornet.com 

REMINDER TO ALL SIG LEADERS  
This is a reminder to all SIG Leaders. The 

quarterly SIG reports for October, November 
and December are due. Please send to 

Neil Stahfest: ncstahfest@msn.com 
or bring to the next General Meeting.  

Thank you. 

F e b r u a r y  2 0 1 0  

 

How To Clean The 
House  

 

1.   Open a new folder on your 
PC. 

2.   Name it 'Housework.' 
3.   Send it to the Recycle Bin. 
4.   Empty the Recycle Bin. 
5.   Your PC will ask you,  

 

'Are you sure you want to 

delete Housework 

permanently?' 

 

6.   Calmly answer, 'Yes' and 

press mouse button firmly 

 

7.   Feel better?  

 

Works   for   me! 
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the Task Bar a pop-up message will say ñPin to 

Windows Explorerò.  Release the mouse button.  If you 

didnôt have it before, youôll see an icon that looks like 

this:     

The next time I 

want to access the 

folder, all I have to 

do is right-click 

once on the folder 

on the Task Bar.  Any other folders that you add to the 

Task Bar will also be located here under the heading of 

ñPinnedò or ñFrequentò (you determine which folders are 

ñPinnedò).  Of course, if this seems like too much work, 

you can always just create a shortcut to a folder on the 

desktop. 

 

Before we leave the topic of the Start Menu and Task 

Bar, I should mention some changes to the Control 

Panel.  If you left click on the Start Button and then click 

on Control Panel, youôll see something like this: 

 

This is the control panel in the 

ñCategoryò view.  A few of the 

utilities have been rearranged but itôs 

pretty much like the one In Windows 

Vista and Windows XP.  The Classic 

view is no longer available, its now 

called an ñIconò view.  You can reach 

it by going to the upper right corner of 

the window where it says ñView by: 

Categoryò (circled in red) and 

clicking on ñCategoryò.  In the pull 

down menu that appears you can 

select Large icons or Small icons.  

The result is the same, only the icon 

size is different.   

 

As in the past, the Control Panel allows you to change 

many of the Windows settings.  Color settings, Firewall, 

Date and Time, Power Options, and many more are 

available here.  The list is extensive. Maybe weôll 

explore this at a later date.   In addition, some add-on 

programs may appear on the Control Panel.  In my case I 

have a CD/DVD burning program installed and an icon  

ñNero BurnRightsò appears on the Control Panel list.    

 

Want to get back to the Category view?  Click on ñView 

by: Small iconsò (or Large icons) and select ñCategoryò.  

Thatôs all there is to it. 

(Continued from page 2) 
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http://www.WorldStar.com  
 

Who's Behind Your Keyboard? 

Hello, everyone! This security article 

is going to be a little different than 

some of the others we've run in the 

past. Usually, I write about a 

security issue that is affecting certain 

programs or a program that will help 

fix a security problem, but today, I'm 

going to talk about the number one 

threat to computer security. 

 

And that is the person sitting behind 

the keyboard (including me!) 

 

Now, I don't want to offend anyone, 

so I'll start by giving you my story. 

 

One day, I was putting together a 

small Web site just for fun. In the 

process of doing that, I decided I 

wanted a small sound effect to play 

when a person ran their mouse over 

one of my images. I figured that 

would be simple enough. I could just 

search the Web for the sound I 

wanted to use. Well, that was a bad 

idea! I downloaded the sound and as 

soon as I played it, my computer 

completely froze. After getting my 

computer started back up in Safe 

Mode, I ran a virus scan and it found 

three viruses on my system. Oh no! 

 

If I hadn't downloaded that sound, 

this would never have happened. 

The sound file I downloaded was not 

from a site I had ever been to before. 

It was free and the file size seemed 

awfully large for a two second audio 

clip. Given all of this, I still 

downloaded the file. Why? Because 

I really wanted that sound, I guess. 

 

The moral of the story is that 

sometimes, we all get carried away 

on the Internet. We start clicking on 

things and downloading things we 

know we shouldn't 

trust. This is what 

gets us all in trouble. 

I can write a million 

warnings about 

viruses and 

vulnerabilities, but the only thing 

that will truly keep your data safe is 

good old fashioned common sense! 

 

Here are some guidelines to follow: 

 

1.) Don't download items from Web 

sites you do not trust. 

2.) Don't install things you do not 

recognize. 

3.) If it seems too good to be true, it 

probably is. 

4.) Ninety-nine percent of viruses 

cannot harm you without you 

clicking OK at some point. 

 

If you follow those tips, you will 

save yourself many, many headaches 

in the future. Until next time, stay 

safe out there, my friends! 

C C C 
 

Download YouTube Videos the 

Easy Way! 

This is a real quick and easy one for 

all our YouTube users out there. Say 

you really like a video - I mean, like 

it enough to want to download it. 

What do you do? 

 

Bookmark it and come back every 

time you want to see it? 

 

Bor-ring! 

 

How about this: 

 

While on YouTube, navigate to a 

video you want to download to your 

computer and up in the address bar 

of your browser, replace the ñYò in 

YouTube with a number 3 and hit 

enter. 

 

Look at this picture for an example: 

 

 

You'll be taken to the 3ouTube site 

where you'll have the choice of 

downloading in MP4 or FLV 

formats! 

 

Time to fill up that hard-drive! 

C C C 
 

Please explain what the Last 

Known Good Configuration is. I'm 

not quite understanding it. 

The Last Known Good 

Configuration  is basically a copy of 

a computer's hardware configuration 

and its driver settings. It is taken 

from the system's registry readings 

when a computer has a good, clean 

boot up. This copy is made for 

whenever a computer fails to boot up 

successfully. When that happens, the 

system's operating system is able to 

pull up the good copy and perform a 

successful startup. 

 

The Last Known Good 

Configuration feature is available for 

any Windows operating system from 

NT on. Also, if your computer does 

happen to have some problems 

during its boot up, Windows will 

detect that and it will actually add 

the copy of your last successful boot 

to your startup menu. That way, you 

can go and access it from that point 

and start your boot up correctly 

again. 

 

This feature is mostly helpful after 

new drivers or devices are installed 

on your system. If either of those 

had an error while the install was in 

process, you can still go back and 

get a clean boot. One more thing: 

Every time your computer boots up 

correctly, the Last Known Good 

Configuration record is replaced 

with the newest one. That way, you 

(Continued on page 8) 
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have the most recent successful boot 

for your computer to start with. Let's 

say that you just installed a new 

driver on your system. It seems like 

the installation was done right, but 

for some reason, your computer will 

not start up like it usually does. 

Well, this is exactly where the Last 

Known Good Configuration comes 

in handy. 

 

To start your computer using the 

Last Known Good Configuration 

that your computer has on record, 

simply start up your computer and 

hit the F8 key on your keyboard as 

it's booting. The Windows 

Advanced Options menu should 

appear and you can use your 

keyboard's arrow keys to scroll 

down to the "Last Known Good 

Configuration (your most recent 

settings that worked)" option. Once 

you've got it highlighted, press 

Enter. 

 

Your computer will then boot up 

successfully and you'll be able to 

look into what caused the problem in 

the first place. Now, keep in mind 

that the Last Known Good 

Configuration feature does not 

automatically fix the problems you 

were having. It will only get your 

computer started so you can 

troubleshoot the rest of the problem 

on your own. Either way, it's an easy 

way to combat your computer 

startup troubles. You can't complain 

about that, now can you?! 

C C C 
 

Delete vs. Backspace 

Work with MS Word tables? Ever 

try to remove cells, rows or columns 

by highlighting them and then hitting 

the Delete key? 

 

What happened? Certainly not what 

you had hoped for, I'm sure. Instead 

of deleting the cells, only the data is 

gone. 

 

Now what? 

 

Well, I suppose you could re-

highlight the cells and then use the 

Table menu, Delete submenu, (or 

for 2007 users it would be the Table 

Tools, Layout tab of the Ribbon) 

but who wants to do all that work? 

 

And, yes, I do realize you could have 

used the Table menu / Layout tab 

from the beginning, but that just 

takes too many steps. 

 

So, if we can't use the Delete key to 

remove cells, what can we use? 

 

Good question and fortunately, I've 

got an easy answer: Backspace. 

 

Yep, that's it. Next time, highlight 

the cells, rows or columns and then 

hit the Backspace key. 

 

If you've highlighted an entire row 

or column, poof! They're gone, data 

and all! 

 

If you happened to have highlighted 

just a few cells, you'll get this handy 

little window where you can tell 

Word how to handle the situation. 

 

 
 

Make your choice and then click 

OK . 

 

So, let's recap:  

 

Delete removes just the cell 

contents. 

 

Backspace removes the cell and its 

contents. 

 

Delete? Backspace? Now it's all a 

simple question of how much you 

want to remove! 

C C C 

 

What's the quickest way to the 

Task Manager? 

All about speed, eh? Well, the 

quickest and easiest way to get to 

your Windows Task Manager is 

simply to right -click an empty area 

of your Task Bar and choose ñStart 

Task Managerò.  

 

Ta-da! An instant view of what your 

system is doing! 

C C C 
 

Firefox Toolbar Customizing 

Is your Firefox toolbar yawn-

worthy? Do you fall asleep 

sometimes just thinking about how 

lame it is? 

 

Well, wake up, because today we're 

going to snazz it up a bit! 

 

Just click View>Toolbars>  

Customize.  You'll see this: 

 

(Continued from page 7) 

(Continued on page 9) 
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Just drag and drop the features you 

want into Firefox's toolbar in any 

order you like to customize. You can 

add spaces, separators and adjustable 

spaces, too, so you can lay it out any 

way you like! 

 

 
 

Now that's cool! 

C C C 
 

When I visit certain Web sites, I 

often get the error message of 

"Done, but with errors on page." 

What does that mean and is there 

anything I can do to fix it? Please 

help! 

Well, to begin, this error usually 

only shows up in Internet Explorer  

and it mainly has to do with 

JavaScript. If the Web site you're 

trying to view uses JavaScript, you 

may run into a script related error, 

which triggers the "Done, but with 

errors on page" message. It is 

usually generated by an error in the 

site's code and unless you have 

access to that code, you probably 

won't be able to fix the error 

yourself. Once the problem hits a 

Web site's code, only the developers 

of the site can get in and fix it.  

 

However, when that error pops up, 

you should still be able to see most 

of the site. Just keep in mind that 

some of its parts may not function 

correctly. You might have a missing 

image or animation here or there, but 

most of the site should still be 

visible. Now, I know some of you 

may be worried about the error 

affecting your computer. You may 

be thinking that it's going to harm 

your PC. Well, I assure you it won't. 

The problem lies within that Web 

site only and there's no way it could 

damage your computer. Plus, if you 

go and visit other sites, you'll see 

that they load up just fine. And once 

the creators of the other site fix their 

code, that one will be viewable again 

as well. 

 

In addition, if you're a Web site 

designer or editor yourself, you'll 

want to keep an eye on your site and 

make sure the "Done, but with errors 

on page" message doesn't pop up at 

any time. If it does, just go in and 

look through your source code. The 

problem usually comes from an 

improper syntax, an incomplete code 

or a script that is placed in the wrong 

HTML section. Just take a look at 

those things and you should be able 

to fix the error rather quickly. Then 

your site will be back up and running 

the way it should be. 

 

As you can see, this error message 

isn't one to panic about. It's 

unfortunate that it happens, but 

there's not really anything you can 

do about it yourself. If there's any 

way you can contact the designer of 

the Web site, do so. They may not 

even know there's a problem, but if 

you tell them, I'm sure they'll get it 

fixed right away. Otherwise, you'll 

just have to sit tight and keep 

checking back until the problem is 

solved. Luckily, it's not an error 

message that can ruin your whole 

day. At least it shouldn't! 

C C C 
 

Cool site: 

Funny Typos 

http://funnytypos.com/ 

 

Typos happen to the best of us. I 

know Iôve had my share. Whether 

Iôm tired or sick, or just not paying 

attention ï they happen. But that 

doesnôt make them any less funny 

when you discover them. 

 

This site is devoted to funny typos 

from all over the world. I donôt 

remember the last time Iôve laughed 

so hard. 

 

The site is setup blog style, so just 

scroll down the page to explore it. 

The most recent entries are at the 

top, with previous ones below them. 

To explore further, click the Older 

Posts link at the bottom of the page 

to travel back through them. 

 

On the right side of the page youôll 

find your other navigation options. 

You can browse by recent post, top 

posts, categories, and recent 

comments. Or if you want to scroll 

down you can click on a tag in the 

tag cloud to select posts. 

 

Have a laugh, I know I did! 

C C C 
 

Hard Drive Maintenance 

Hard drives are one of the most 

important components of the 

computer system. A general 

unmonitored hard drive has a life 

term of about three to five years. A 

hard drive may fail without any prior 

warning, leading to the loss of all the 

data on the disk. And that's exactly 

why it's so important to keep your 

hard drive in good condition. This 

(Continued on Page 10)  
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tutorial will guide you through all 

the steps you can use to improve the 

health of your hard drive. Here we 

go!  

 

Step 1: Check the Drive for Errors 
1.) Go to Start, My Computer. 

2.) Right click on the C: drive and 

choose Properties. 

3.) Under the Tools tab, click on the 

Check Now button. 

4.) Check both the disk options and 

then click on the Start menu. 

5.) If a prompt for a restart appears, 

choose Yes. 

6.) Windows will then restart, check 

and repair any corrupted files on 

your drive. 

 

Step 2: Convert the File System of 

Your Drive to NTFS without 

Losing Any Data 
Windows uses either the NTFS or 

FAT 32 file system to maintain the 

records of all your files. The main 

advantage of NTFS is if your system 

crashes, the NTFS file system is 

capable of automatically fixing any 

problems that may arise. It's also 

capable of detecting and isolating 

bad sectors on your hard drive 

automatically. Those same features 

are not provided with the older FAT 

32 system. To make sure your 

computer is using NTFS, follow 

these steps: 

1.) Go to Start, Run. 

2.) Type in "cmd" and then press 

Enter. 

3.) When the prompt window opens, 

type "convert j: /fs:ntfs," assuming 

you're converting drive J. (If step 1 

is not performed, the conversion 

may fail, so please follow all the 

steps sequentially). 

 

Step 3: Defragment the Drive 
As files are copied to and deleted 

from the hard drive, a process called 

fragmentation starts to affect 

performance and stability. Large 

files are scattered all over the drive 

and the drive has to work harder to 

locate all the different fragments. 

Therefore, the hard components have 

to cover the entire drive very 

quickly, just to access a single file. 

As a result, the hard driveôs life is 

shortened. 

 

To overcome that problem, a utility 

called the disk defragmenter is 

provided with Windows. Here's how 

to use the disk defragmenter utility: 

 

1.) Go to Start, My Computer. 

2.) Right click on the C: drive and 

select Properties. 

3.) Under the Tools tab, click on 

Defragment Now. 

4.) Now, analyze the drive and then 

hit Defragment. 

5.) You should do it at least once a 

month to keep your hard drive in its 

proper working condition. 

 

Good luck! 

C C C 
I just recently started using 

Windows Vista and I've noticed 

that there are some programs 

running that don't really need to 

be, but I can't figure out how to 

turn them off. I know you've 

discussed this topic for Windows 

XP before, but how do we do it in 

Vista? Please help! 

To begin, all computers have what 

are called services and those are 

basically special programs that take 

care of all the different functions 

your computer has to deal with in 

order to run properly. Some of those 

services are put in place to support 

some of the other programs on your 

computer, but in reality, a lot of 

them are unnecessary. Some of them 

sort of just sit there and take up 

space, which is quite annoying when 

you think about it. I'm sure 

Microsoft had good reasoning for 

putting those services in place, but 

when it comes down to it, you don't 

really need all of them running all 

the time. I mean, most of them run 

the entire time you have your 

computer turned on and that's just 

not necessary! 

 

So, if you think there are some 

services running on your computer 

that you don't really need (like the 

person who asked this question), 

luckily, there is an easy way to turn 

them off. Windows Vista has a 

utility called the Microsoft 

Management Console (MMC), 

which is what you can use to turn off 

all those unwanted services. 

 

To open the MMC, click on the 

Start button and in the search box 

below it, type in "services.msc." 

When your results show up, scroll 

through and click on the one that 

simply says Services. A new 

window (it's called the Service 

Console) will then open for you and 

you will be able to see all of the 

services you have running at the 

present time. 

 

As you can see, the Service Console 

gives you a lot of information about 

each service. It also allows you to 

sort through the services by the titles 

of Description, Status and Startup 

Type. If you want to learn more 

about a specific service, just click on 

it and a detailed description will then 

pop up on the left hand side that you 

can read through. (Note: In order to 

see the description, you need to be in 

the Extended mode, so keep that in 

mind!) 

 

I highly suggest that you read 

through each of the services before 

you start closing them down. Like I 

said before, some of these services 

support other programs on your 

computer that you may use on a 

regular basis, so you'll definitely 

want to do your homework on each 

one before you disable them. You 

may even want to do a little further 

research on the ones you're not 100 

percent positive about, just to be sure 

you're disabling the right services, 

(Continued from page 9) 
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etc. Then once you've decided which 

ones you don't need, just simply 

right click on the service name and 

hit Stop. 

 

That's all there is to it. It's a pretty 

easy process to go through thanks to 

the MMC, so just take your time and 

be sure you're turning off what you 

really want to. If you do that, you'll 

be good to go from now on! 

C C C 
Five Ways to Select Text With 

Your Mouse 

When youôre writing something in 

MS Word or  other of f ice 

applications, you often want to select 

text.  You can use the mouse to 

highlight text by dragging the mouse 

over it .   

 

Five other ways to highlight text in a 

word document. 

 

1. To select a word, double click it. 

2. To select a single line of text, 

click in the left margin next to the 

line. 

3. To select a sentence, hold down 

the CTRL key and then click 

anywhere in the sentence. 

4. To select a paragraph, click three 

times in the paragraph, or click 

twice in the left margin next to 

the paragraph. 

5. To select the entire document, 

click three times in the left 

margin. 

C C C 
 

Now, Where Did I Save It? 
Here's a tip idea that stems from a 

reader question! Specifically, she's 

looking to put the file name in the 

footer of an MS Word 2007 

document and she can't seem to 

locate that option in the new 

program. 

 

So, let's go search for the file name 

field for Word 2007's footers. 

 

First, you need to create the 

document's footer. That can be 

done under the Insert tab on the 

ribbon, Footer button. 

 

 

 

 

 

 

 

 

 

 

 

Once you're in the footer, under 

Header and Footer Tools, the Design 

tab will open. 

 

From that tab, choose the Quick 

Parts button. 

Choose Field from the Quick Parts 

list. 

 

In the Field dialogue window, 

choose FileName in the left column. 

In the middle column, choose the 

formatting  you want Word to use 

for the file name. 

 

Finally, in the right column, be sure 

to check the "Add path to file 

name" checkbox if you want the 

entire location of the file in the 

footer. Without that option checked, 

you'll only get the file name and not 

the actual location where it was 

saved. 

 

Click OK  to save your choices and 

return to the document's footer. 

 

Voila. You'll never have to wonder 

where you saved a file again! 
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Cleaning Your Laptop 
Have you made the switch from a 

desktop PC to a laptop? Several 

people have and although they may 

be easier to carry around and travel 

with, they still need 

to be cleaned, don't 

they? 

 

Laptops aren't as easy 

to open up and clean 

as desktops are, but it 

can be done. To get 

started, just make 

sure your computer is 

turned off and 

unplugged. You 

should also remove 

(Continued from page 10) 
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